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ABOUT THIS GUIDE
The Web Management software is a suite of HTML-based applications 
that is shipped with the CoreBuilder® 9400. This guide describes the 
applications, including an overview and information on installation and 
setup.

This guide is intended for network administrators who are responsible for 
managing 3Com switching devices with the Web Management tools.

If the information in the release notes that are shipped with your product 
differs from the information in this guide, follow the instructions in the 
release notes.

Most user guides and release notes are available in Adobe Acrobat 
Reader Portable Document Format (PDF) or HTML on the 3Com World 
Wide Web site:

http://www.3com.com/

Conventions Table 1 and Table 2 list conventions that are used throughout this guide.

Table 1   Notice Icons

Icon Notice Type Description

Information note Information that describes important features or 
instructions

Caution Information that alerts you to potential loss of data or 
potential damage to an application, system, network, 
or device

Warning Information that alerts you to potential personal injury
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Year 2000 
Compliance 

For information on Year 2000 compliance and 3Com products, visit the 
3Com Year 2000 Web page:

http://www.3com.com/products/yr2000.html

Table 2   Text Conventions

Convention Description

Screen displays This typeface represents information as it appears on the 
screen.

Commands The word “command” means that you must enter the 
command exactly as shown and then press Return or Enter. 
Commands appear in bold. Example:

To remove the IP address, enter the following command:

ip interface remove

The words “enter” 
and “type”

When you see the word “enter” in this guide, you must type 
something, and then press Return or Enter. Do not press 
Return or Enter when an instruction simply says “type.”

Words in italics Italics are used to:

■ Emphasize a point.

■ Denote a new term at the place where it is defined in the 
text.

■ Identify menu names, menu commands, and software 
button names. Examples:

From the Help menu, select Contents.

Click OK.
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 WEB MANAGEMENT OVERVIEW
This chapter describes the components in the Web Management suite of 
applications for the CoreBuilder® 9400. The chapter covers these topics:

■ Web Management Overview

■ Embedded Web Management Applications

■ Installable Web Management Help and Other Tools

■ Launching Web Management Applications

■ Logging Out

Figure 1 shows the opening Web Management screen.

Figure 1   Opening Screen of Web Management 
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Web Management 
Overview

The Web Management suite of features consists of embedded Web 
Management applications and installable tools:

■ Embedded Web Management applications — Use the embedded 
Web Management applications for most of your device configuration 
and management tasks. You can manage a single port or device, or, 
using multiple windows, you can manage multiple devices. This 
software, which is part of the system software image, contains:

■ WebConsole — An HTML-based set of configuration forms. See 
“WebConsole Tab” on page 12 for details.

■ DeviceView — A Java-based application that displays a real-time 
image of the device. You can manage each port, or the entire 
system, by clicking on the part of the image that you want to 
manage. See “Browser and Platform Requirements” on page 9 
and “DeviceView Tab” on page 14 for details.

■ Performance features — Dynamic monitoring through graphing 
of Ethernet interfaces. See “Performance Tab” on page 18 for 
details.

■ Help — The configuration form on which you set up the installable 
Help as well as access to links to support information on the 3Com 
Web site. For how to install Help for the configuration forms, see 
Chapter 2.

■ Installable tools — Install some or all of these optional tools on your 
workstation from the Software and Documentation CD that is shipped 
with your system:

■ DeviceView accessories — To set up e-mail notification for 
Status Logging, as described in Chapter 2

■ WebManage Framework — To group your access links to the 
devices that you manage, as described in Chapter 2.

■ Form-specific Help — To access hypertext information about the 
fields in the WebConsole, DeviceView, and Performance forms. See 
Chapter 2 for details.
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Browser and Platform
Requirements

The Web Management suite of applications has certain dependencies, as 
described in this section. 

Color Recommendations

The minimum graphics capability is SVGA (800x600 resolution). For best 
performance, use XGA (1024x768 resolution).

Browser Support

Web Management requires Microsoft Internet Explorer 4.01 or later OR 
Netscape Navigator 4.03 or later.

If you are using Netscape Navigator 4.03 or 4.04, be sure to install the 
Netscape JDK 1.1 Patch. Download the patch from this URL:

http://help.netscape.com/filelib.html#smartupdate

If you are using Internet Explorer, install the latest 4.01 Service Pack 1. 
This service pack makes Internet Explorer Year 2000 compliant and fixes 
other product support issues. Download the 4.01 Service Pack 1 from the 
following URL:

http://www.microsoft.com/msdownload/iebuild/ie4sp1_win32/en/
ie4sp1_win32.htm

If the link is not available, download from the Microsoft home page:

http://www.microsoft.com

See “Web Management and Internet Explorer” and “Web Management 
and Netscape Navigator” in Chapter 3 for more details.
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Platform Requirements

Table 3 lists the platforms that support the Web Management features.

Embedded Web 
Management 
Applications

With the embedded Web Management applications, you can manage 
your system using a Web browser. 

The embedded Web Management applications, accessed from the Tabs 
panel, are WebConsole (including Configuration forms and wizards), 
DeviceView, Performance monitoring charts, and Help configuration 
forms and 3Com support links. See Figure 2.

Table 3   Platform Support for Web Management Features

Feature PC UNIX

Embedded Web Management Applications

WebConsole ✓ ✓
DeviceView ✓ ✓

Performance ✓ ✓

Configuration form to set up Help, 
plus links to 3Com support sites

✓ ✓

Installable Tools

Form-specific Help ✓ ✓

WebManage Framework, to 
customize your access to devices

✓

DeviceView accessories, such as 
e-mail notification for Status Log

✓



Embedded Web Management Applications 11
Figure 2   Parts of the Web Management Opening Screen

Interface Description The screen for the embedded Web Management applications is divided 
into three areas, shown in Figure 2 and described here:

■ Tabs panel — At the top of the Web Management screen, the Tabs 
panel has four tabs: 

■ WebConsole tab — When you select this tab, the menu tree lists 
folders for the parameters that you can configure and view for the 
device to which you are connected. See “WebConsole Tab” on 
page 12 for details.

■ DeviceView tab — When you select this tab, you see an image of 
the device. You can configure some system and port parameters 
from this view. See “Browser and Platform Requirements” on 
page 9 for the required versions of Java-based browsers and 
“DeviceView Tab” on page 14 for more details on the functionality 
of this view.

Workspace

Tabs panel

Menu tree
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■ Performance tab — When you select this tab, the menu tree lists 
charts that support dynamic monitoring. See “Performance Tab” 
on page 18 for more details.

■ Help tab — When you select this tab, the menu tree lists the Help 
configuration form and several links to 3Com support sites. The 
menu tree also displays links to the Contents and Index for the 
Help files, which connect you to the Help configuration form until 
you have installed and configured the Help files. See “Setting Up 
the Form-Specific Help Files” on page 24 for Help installation. The 
links become active after you configure the Help.

To access Help for the configuration forms, you must install the 
supplemental Help tools. See Chapter 2.

■ Menu tree — The menu tree frame at the left of the interface lists the 
menu options. Many of these options are the same as those found in 
the Administration Console command line interface. Click a folder to 
view the menu options, shown as configuration form icons. Click a 
form icon to view the associated form in the workspace. See Figure 3.

■ Telnet icons — To configure system parameters that are not 
supported through the WebConsole, click a Telnet icon on the 
menu tree to launch a Telnet session to the Administration Console 
on the device. See Figure 3.

■ Workspace — The workspace frame of the interface displays the 
configuration form for the menu option that you select. See Figure 3.

WebConsole Tab In the WebConsole application, the menu tree of folders contains icons 
for options that you can change to manage your device. Click an icon to 
view the related configuration form.

Using the
WebConsole

To modify many of the parameters and attributes on your system, follow 
these steps:

1 In the menu tree, click the folder of the feature that you want to modify. 
See the menu tree in Figure 3. Example: Click System. The expanded 
System menu appears in the menu tree, showing the folders and form 
icons for the options with which you configure System parameters.

2 Click another folder or the form icon for the feature that you want to 
configure. Example: Click Password. The System Password configuration 
form appears.

3 To fill in the form, type the required information. To get Help on a form 
and its fields, click the Help button at the bottom of the form. You must 
first have installed the form-specific Help; see Chapter 2.
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Figure 3   Using the WebConsole

4 Click Next (on some forms) or Apply to finish the configuration. Next 
displays an additional form with more fields for you to fill in. Apply 
completes the requested configuration. 

For some forms, the system may reset before the changes take effect.

5 To configure parameters that are not supported on the WebConsole, click 
a Telnet icon, for example, serialPort, to launch a Telnet session to the 
Administration Console on the device, and then use the command line 
interface to configure the parameter. For details on the commands in the 
Administration Console, see the Command Reference Guide.

Configuration Wizard

The WebConsole menu tree also contains an icon called Define Wizard 
for the Trunk Definition configuration wizard. Use the wizard to create 
valid configurations, modify attributes and parameters, and prevent 
common configuration mishaps. See Figure 4.

Telnet icon



14 CHAPTER 1: WEB MANAGEMENT OVERVIEW
Using the
configuration wizard

To use the Trunk Definition configuration wizard, click the wizard icon 
and follow the instructions. 

Figure 4   Opening Screen for the Trunk Definition Wizard

DeviceView Tab The DeviceView application actively monitors the device and allows you 
to configure system and port parameters in an Internet browser. The 
image in the DeviceView workspace is “live,” that is, you can monitor 
each port or the entire system in real-time.

Using DeviceView 

To use the DeviceView application, on the Tabs panel of the Web 
Management opening screen, click the DeviceView tab to launch an 
image of the device to which you are connected. See Figure 5. (See 
“Browser and Platform Requirements” on page 9 for information about 
setting up the required JDK 1.1 Patch for certain browser versions.)

Wizard icon
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Figure 5   DeviceView Opening Screen

About the Device Image

To access a subset of the management options that are available through 
the WebConsole tab, click on the device image in the workspace (shown 
in Figure 6). Table 4 lists the colors that indicate system and port status on 
the image.

A blue border outlines the part of the device image under your pointer.

Figure 6   DeviceView Image

Table 4   Status Color Codes

Color/Shade Indicates this status

Green Enabled, link present

Partial shading (dark edge) Disabled, link present

Black Enabled, link absent

Gray shading Disabled, link absent

Red Partitioned, link present

Yellow Resilient, link absent
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If you have installed the supplemental Help, click the Help button below 
the image for more information. See Chapter 2 for Help installation.

Configuring Parameters in DeviceView

To configure a parameter for the system or a port, click the image of the 
area that you want to configure. Configuration forms appear in the 
DeviceView workspace:

■ To view and modify system-level parameters, click anywhere along the 
outline of the chassis image.

■ To view and modify port-level parameters, click the image of the port 
that you want to configure. 

Selecting Multiple Ports

To select multiple nonconsecutive ports for configuration in DeviceView, 
press and hold the Shift key as you click the image of each port that you 
want to configure. To select consecutive ports, press and hold the Control 
key while you click the first port and the last port in the series.

Using Status Logging

DeviceView has a Status Log that monitors system and port changes on 
the device and displays the events in a log. See Figure 7.

Figure 7   Status Log in DeviceView

For Internet Explorer, you may want to follow the instructions to improve 
Status Logging functionality in “Improving DeviceView in Internet 
Explorer” in Chapter 3. 

You can set the Status Log to monitor the system or the ports in any 
combination. To enable Status Logging options:

1 Select the DeviceView tab and then, in the menu tree, click DeviceView.

2 In the menu tree, click Configuration. The DeviceView configuration form 
appears. See Figure 8.

3 In the Status Logging field, select enabled. For other options, click Help.
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4 Click Apply.

5 In the menu tree, click Status Log and configure the options for sending 
e-mail of system or port changes. For information on the options, click 
Help.

If you want to enable e-mail notices and you have not installed the 
supplemental DeviceView accessories, install them now. See Chapter 2.

6 In the Status Log Configuration form, click Apply.

For the changes to take effect:

■ In Netscape, reload the browser. 

■ In Internet Explorer, refresh the browser window.

The Status Log (Figure 7) now displays information about your mail 
server.

Figure 8   DeviceView Configuration Form
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Performance Tab You can monitor certain aspects of performance for your system. See the 
Help for information on choosing options that do not affect network 
performance. See Chapter 2 for how to install Help.

Using the Performance Features

To launch the dynamic monitoring functionality of the Performance tool:

1 Select the Performance tab on the Web Management opening screen. 
The menu tree expands to show the Performance charts for Ethernet. 

2 Select the chart that you want to view:

■ Ethernet Bandwidth Utilization — Bytes that are transmitted or 
received over specified ports

■ Ethernet Packet Volume — Packet volume for unicast, broadcast, or 
multicast packets over specified ports

■ Ethernet Packet Sizes — Size of packets passing through the ports

Customizing Your Performance Monitor 

To customize your performance features, you can create the ideal chart 
size for your desktop environment and establish the refresh rate so that 
your network statistics are updated by the hour, minute, or second. To 
customize your configuration:

1 On the Web Management opening screen, click the Performance tab. The 
Ethernet menu tree appears.

2 In the menu tree, click the Configuration option. The Web Monitoring 
configuration form appears. See Figure 9.

3 In the Chart Size field, select the chart size: Large (400 pixels) or Small 
(200 pixels).

4 Type the refresh rate in this format: Hours:Minutes:Seconds.

5 Type the item history for moving charts, that is, select how many times 
items change in a moving chart.

6 Click Apply.

If you have installed the form-specific Help files, click the Help button to 
read more information on these options. See Chapter 2 if you have not 
installed the supplemental Help files.
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Figure 9   Web Monitoring Configuration Form

Help Tab The fourth tab of the Web Management opening screen contains these 
links:

■ The Help configuration form — Type the path to the directory in 
which you installed your Help files. Click Apply to complete the 
software link. Now you can access Help from each configuration form. 
When you install the Help, the links to the Help Contents and Help 
Index become active. If you have not installed the Help, these links 
connect you to the Help configuration form.

■ Various 3Com support sites on the Web — Click a link to view the 
3Com contacts list, support page, and home page.

Installable Web 
Management Help 
and Other Tools

Download the installable Web Management tools from the Software and 
Documentation CD that is shipped with your system. Using the 
installation wizard, you can choose to install one or more of these tools:

■ WebManage Framework — To facilitate the way that you group 
and access devices and tools. See “WebManage Framework” next.

■ DeviceView Accessories — To enable e-mail notification for Status 
Log on the embedded DeviceView application. See “Enabling E-mail 
Notification for Status Log” on page 22 for details.

■ Help — To learn more about the embedded configuration forms. See 
“Form-Specific Help Files” on page 21 and “Setting Up the 
Form-Specific Help Files” on page 24 for details.
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WebManage
Framework

Use the WebManage Framework to organize the devices that you 
manage into easily accessible groups. You can also create a folder for 
each group, as shown in Figure 10 and described next.

For best results, first create the folders, then create the link to the devices.

Figure 10   Integrated Web Management Configuration Form

On the Devices tab:

■ To add a folder — In the Add a Folder area of the form, type a 
meaningful name (such as Engineering-A or AccountingLab-3).

■ To add a device — In the menu tree, click the folder where you want 
the device. In the Add a Device area, in the Name field, enter a 
meaningful name (such as 3500-1 or 9K-16slot-1). In the IP field, type 
the IP address.

■ To remove a device or folder — In the menu tree, click the folder or 
device name. In the Delete a Device or Folder area of the configuration 
form, click OK.



Installable Web Management Help and Other Tools 21
Form-Specific
Help Files

Each configuration form has a Help button and one or more related Help 
topics. See Figure 11. 

Many Help pages also have additional links to the HTML-version of the 
Implementation Guide as well as links to other information in the banner 
at the top and in the row of links at the bottom of the Help page.

See Chapter 2 for installation and setup instructions.

Figure 11   Help Page

Help 
banner

Additional
links
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Launching Web 
Management 
Applications

Depending on which optional files you decide to install, you can manage 
a single device, access Help from each form, use WebManage Framework 
to organize your access to multiple devices, or enable e-mail notification 
of Status Log events.

Managing a Single
Device

To use the embedded Web Management applications, you need not 
install any of the optional files. Open a new Internet browser window on 
your workstation and enter the IP address of the system that you want to 
manage. The Web Management opening screen appears, with the 
WebConsole, DeviceView, Performance, and Help tabs. (Use the Help tab 
to configure the location of your Help files if you choose to install them.)

Launching the
Form-Specific Help

If you have installed and configured Help (see Chapter 2), access Help 
from the Help button for each form as you manage your device, or use 
the Contents and Index links on the Help tab to search for information on 
a topic.

Launching the
WebManage

Framework

If you have installed WebManage Framework, from the Windows 95 or 
NT Start menu, select Programs, and then WebManage, and then 
WebManage again.

Enabling E-mail
Notification for

Status Log

If you have installed DeviceView Accessories, see “Using Status Logging” 
on page 16 for instructions on how to configure your device to send 
e-mail notification of Status Log events in the DeviceView application.

Logging Out To disconnect a session in Web Management, close the browser window 
or enter another IP address.
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This chapter covers installation and set up for the additional tools that 
you can install locally to help manage your system:

■ Installing Supplemental Web Management Tools

■ Setting Up the Form-Specific Help Files

Installing 
Supplemental Web 
Management Tools

Use the file named webmanagev30.exe  to launch the wizard that 
installs some or all of the supplemental tools.

Windows Installation If you choose to install the additional Web Management files on a PC that 
runs Windows 95 or Windows NT or on an NT server, first download the 
executable file.

To download the installable tools:

1 Close all open programs and applications.

2 Find the webmanagev30.exe  file in the CD directory on the Software 
and Documentation CD that is shipped with your system.

3 Double-click the filename and follow the instructions in the installation 
wizard. Choose one of these installation options: 

■ Custom — Installs one or more supplemental Web Management 
components that you specify in a checklist

■ Help Files Install — Installs only the form-specific Help files for the 
Web Management embedded forms. You can choose to install one or 
more of five 3Com switching product’s Help files.

■ Typical — Installs all supplemental components, including the 
WebManage Framework, DeviceView accessories (such as e-mail 
options for Status Logging), and the Help files

If you plan to group multiple devices, choose the Typical installation or 
choose the Web Management option in the Custom installation.
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4 Decide whether to reboot:

■ If you have selected Help Files Install or Typical and are using 
Windows 95, the wizard prompts you to reboot your system. You 
must reboot the system to complete the installation process. 

If you are running Windows NT, the system does not need a reboot.

■ If you have selected the Custom installation and chosen only the Help 
files, you do not need to reboot your system. 

The Web Management Install wizard installs the Web Management icon 
into the directory that you specified in step 3. 

5 To launch your applications, see Chapter 1.

UNIX Help
Installation

A UNIX .TAR file containing the Web Management Help system is 
available on the Software and Documentation CD.

To install Help files on your UNIX workstation:

■ Locate the HELP.TAR file in the CD directory.

■ To extract the .TAR  file into your Web server directory, use this 
command: tar - xvf HELP.TAR

6 To launch your applications, see Chapter 1.

Setting Up the 
Form-Specific Help 
Files

To access Help for the system, install the supplemental Help files on your 
workstation or NT server using Help Files Install or Typical in the 
installation wizard. See “Windows Installation” or “UNIX Help 
Installation” earlier in this chapter.

To configure the location of the Help files for the first time: 

1 In the Tabs panel of the WebConsole opening screen, select the Help tab.

2 In the menu tree, click Device and then click Configuration.

The Help Server configuration form appears.

3 In the Help Installation URL field, type the complete path to where you 
stored the Help files. See the examples on the form in Figure 12. 

Do not end the URL with a slash (/).
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Figure 12   Help Server Configuration Form

4 Click Apply. 

The system displays a message that indicates that the Help Server has 
been set properly. 

5 To link the Help to Web Management, select any item in the menu tree 
on the WebConsole opening screen. Then click the Help button on the 
resulting form.

Help is now configured for your system. 

6 To access Help, click the Help button on any Web form, see Figure 11 on 
page 21 for the location of links to the Contents list and the Index for the 
Help system. 

The banner at the top and the row of links at the bottom of each Help 
page provide access to the Start page (containing Web Management 
overview information), Help Contents, Help Index, 3Com Technical 
Support, and the 3Com Corporation home page.
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 TROUBLESHOOTING
This chapter covers the following topics:

■ Browser Issues

■ Troubleshooting the Web Management Software

Browser Issues In addition to the tips in this section, see these sources of information:

■ “Browser and Platform Requirements” in Chapter 1

■ Any Web Management System Issues or Known Problems in the 
release notes that are shipped with your product

■ The Web Management readme file

Web Management
and Internet Explorer

If you are using Internet Explorer, install the latest 4.01 Service Pack 1. 
This service pack makes Internet Explorer Year 2000 compliant and fixes 
other product support issues. Download the 4.01 Service Pack 1 from the 
following URL:

http://www.microsoft.com/msdownload/iebuild/ie4sp1_win32/en/
ie4sp1_win32.htm

If the link is not available, download the service pack from the Microsoft 
home page:

http://www.microsoft.com

Improving
DeviceView in

Internet Explorer

To improve DeviceView download speed or to enable the Status Log 
options that send e-mail messages regarding system and port status 
changes to one or more e-mail addresses when you use Internet Explorer 
to manage devices, you change several security settings.

To access these e-mail options, install the additional Web Management 
files and enable Status Logging. Click the Help tab for additional 
information on DeviceView Status Log options. See Chapter 2 for 
information on installing the supplemental files.
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Improving DeviceView Download Speed

To improve the download speed for DeviceView image in Internet 
Explorer:

1 Open an Internet Explorer browser window.

2 From the View menu, select Internet Options. 

The Internet Options dialog box appears. See Figure 13.

3 To view security options, select the Security tab. 

Figure 13   Security Tab on the Internet Options Dialog Box

4 From the Zone drop-down list, select Trusted sites zone. 

The Trusted sites zone dialog box appears. See Figure 14.

5 Click the Add button.

6 Remove the check mark from the Require server verification check box 
when you add device information. 

7 In the Add this Web site to the zone field, type http://  plus the IP 
address of the device that you want to manage through Web 
Management. Example: http://151.108.129.154

This information is added in the Web sites field. 

8 After you have added the devices that you want to manage, click OK. 
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Figure 14   Trusted Sites Zone Dialog Box

Enabling Status Log E-Mail Options on Internet Explorer

To ensure that the e-mail option for Status Log is available when you use 
Internet Explorer, follow the steps in “Improving DeviceView Download 
Speed” on page 28 and then take these steps:

1 In the Internet Options dialog box, click the Security tab and then click 
the Custom option button at the bottom of the dialog box to set custom 
security settings (Figure 13). 

The Settings button to the right of this option is now available.

2 Click Settings. The Security Settings dialog box appears (Figure 15).

3 In the Reset custom settings area, select Low security and click Reset.

4 In the Security Settings area, scroll down to Java Permissions and select 
the Custom option button. 

The Java Custom Settings button is now available.

5 Click Java Custom Settings. 

The Internet zone dialog box appears. See Figure 16. 

6 Click the Edit Permissions tab.

If the options listed under Unsigned Content cannot be configured, verify 
that you are using the latest version of Internet Explorer. 

7 In the Run Unsigned Content choices, click the Enable option button.

8 To close the Internet zone dialog box, click OK. To close the Security 
Settings dialog box, click OK. In the Internet Options dialog box, click 
Apply. Click OK to close the Internet Options dialog box. 
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Figure 15   Security Settings Dialog Box

Figure 16   Edit Permissions Tab
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Web Management
and Netscape

Navigator

If you encounter problems accessing Help files from Web Management 
applications when you use Netscape Navigator, clear the browser memory 
cache and disk cache and restart the browser.

To clear the cache in Netscape Navigator:

1 In the browser window, from the Edit menu, select Preferences. 

2 In the Category menu tree, click Advanced and then click Cache in the 
Advanced folder.

The browser cache options appear to the right of the menu tree.

3 Clear the memory and disk cache by clicking the appropriate buttons on 
the cache options form.

4 Restart the browser.

The Netscape browser does not always shut down. If it does not shut 
down, press Ctrl+Alt+Delete and end the Netscape browser task. 

Troubleshooting 
the Web 
Management 
Software

If you are unable to run the Web Management software, verify the 
accuracy of your CLASSPATH environment variable. 

By default, the installation wizard adds two directories above your 
existing CLASSPATH: C:\3Com .

Your directories may be different if you did not select the default C:\3Com  
directory during installation.

If your system already has an existing CLASSPATH before you install the 
additional Web Management files, the necessary 3Com directories are 
added above yours. As a result, your classpath may look like this:

C:\3Com;C:\java\classes;C:\java\applets\myclasses;

If you modify your classpath and do not include the 3Com directories 
(and possibly if you do not list them before any other directories in your 
classpath), the Web Management components may fail to run properly.

In Windows 95, your CLASSPATH is set in the autoexec.bat  file. It usually 
appears in this format:

SET CLASSPATH=C:\3Com;

In Windows NT, your CLASSPATH is set through the System icon in the 
Control Panel. Ask your system administrator if you do not know how to 
change your environment variables.
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Examples of Good
and Problematic

CLASSPATH Settings

This minimal setting is required for Web Management:

SET CLASSPATH=C:\3Com;

The following setting is also acceptable:

SET CLASSPATH=C:\3Com;C:\java\classes;

This setting can potentially cause problems:

SET CLASSPATH=C:\java\classes;C:\myclasses;C:\3Com;

The next setting results in unspecified behavior, because certain 3Com 
Web Management directories are not included. An unspecified 
CLASSPATH has similar results. In either case, the installed Web 
Management applications may fail to run:

SET CLASSPATH=C:Local Status Log

Additional Resources
for Solving Problems

If you still encounter problems after you try the tips offered in this 
chapter, consult these sources of information: 

■ Any Web Management System Issues and Web Management Known 
Problems in the release notes that are shipped with your system.

■ Your network supplier

■ The Technical Support appendix in the release notes for your system
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